Troubleshooting Guide for Cisco Unified Contact Center Management Portal

Release 7.5(1)

July 2008

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
     800 553-NETS (6387)
Fax: 408 526-4100
TABLE OF CONTENTS

1. Initial checks ........................................................................................................... 7
   End User Checks .................................................................................................... 7
   Application Error Codes ....................................................................................... 7
   Critical Services .................................................................................................... 7
   All Servers ............................................................................................................ 7
   Database Servers ................................................................................................. 7
   Web Application Servers ...................................................................................... 8
   User Rights ........................................................................................................... 8
   Network Connectivity ............................................................................................ 8

2. Windows Operating System Checks ............................................................... 9
   Event Logs ............................................................................................................. 9
   Disk Space and Memory Usage ............................................................................ 9

3. SQL Server Checks ........................................................................................... 10

4. Unified Contact Center Management Portal Checks ................................... 11
   Connectivity ......................................................................................................... 11
   Web Application Server to Database Server ....................................................... 11
   Database Server to IPCC ................................................................................... 11
   SQL Server Transactions ..................................................................................... 11
   Logs ...................................................................................................................... 12
   AppServer Log .................................................................................................... 12
   IIS Log Files ....................................................................................................... 12
   Audit Reporting ................................................................................................... 13
   System Monitoring ............................................................................................... 13

5. Common Issues ................................................................................................... 14
   Database Server Errors ....................................................................................... 14
   Required Initial Data Import Never Stops ........................................................... 14
   Active Importer Server Crash ............................................................................. 14
   Inactive Importer Server Crash .......................................................................... 15
   Recovery after No Disk Space Available ............................................................ 18
   Network Disconnects in Replicated Environments .............................................. 19
Replication Fails on Replication Restart ................................................. 20
Re-synchronization Replication ............................................................... 21
Domain Controller was Rebooted .......................................................... 22
Taking a Cisco Admin Workstation Offline .......................................... 22
System Monitoring / Monitoring Report Shows Errors .......................... 22
Cannot Login to Phone / Phone Does Not Ring ................................. 22

Web Application Server Errors ............................................................. 22
A Tenant’s Resources are not being moved to the Correct Folder after Import ............................................................ 22
Unable to See Resources in System Manager ....................................... 23
Unable to Provision Resources through System Manager? .................. 23
Resource Stays in Pending Active State Forever .................................. 23
When Creating New Item, Error Indicates Resource Already Exists ..... 24
New Skillgroups Enter Error State ....................................................... 24
Unable to Update Skillgroup Memberships ......................................... 25
Unable to see Related Resources in System Manager .......................... 25
Unable to Bulk Load Resources in System Manager ............................ 25
Web Browser Displays “No connection could be made because the target machine actively refused it” ..................................................... 26
Web Browser Displays “The page cannot be found” .............................. 26
Supervisor User has no Agents or Skillgroups menu options .............. 26
Sharing IPCC Lines ........................................................................... 27
Error Importing Phone ....................................................................... 27
Phone Button Templates ..................................................................... 27
Can’t See Audit Reports in Management Portal? ................................. 27
“Object reference not set to an instance of an object” When Running a Report ................................................................. 27
No Data in Report ............................................................................. 27
Unable to Print Reports ....................................................................... 28

6. Index ........................................................................................... 29
PREFACE

Purpose
This document explains how to administer and provision the Unified Contact Center Management Portal platform.

Audience
This document is intended for all users of the Unified Contact Center Management Portal, from high-level administrators to team supervisors. The reader needs no technical understanding beyond a basic knowledge of how to use computers.

Organization
Chapter 1, "Initial Checks"
  Lists the initial checks to be made if experiencing problems with the Unified Contact Center Management Portal.

Chapter 2, “Windows Operating System Checks”
  Describes how to check aspects of the Windows platform, including memory usage and disk space.

Chapter 3, "SQL Server Checks"
  Describes how to check for possible SQL Server issues.

Chapter 4, "Unified Contact Center Management Portal Checks"
  Explains how to troubleshoot connectivity problems, and where to find diagnostic information within the Management Portal.

Chapter 5, "Common Issues"
  Describes some problems commonly encountered while using the Management Portal, and how to fix them.
Obtaining Documentation, Obtaining Support, and Security Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, security guidelines, and also recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:

1. INITIAL CHECKS

End User Checks

- Exact operation being performed
- Names, dates and other parameters being used in that operation. For audit reporting errors, this should include:
  - Which report was run
  - What from/to dates the report was run using
  - Which users are affected
- Details of the behavior
- Any error message shown
If possible, a screen shot of the end result or error should be taken.

Application Error Codes

The Management Portal does not use status codes to convey information through the system. Its user friendly error codes, combined with the context of what a user was doing when they got the error, should be sufficient to diagnose and resolve problems.

The Management Portal also displays errors returned by the ICM and CallManager. These are visible through the audit reports provided and also in the history tab for each resource item. These ICM and CallManager error messages are always displayed in US English and are documented on the Cisco web site.

Critical Services

All Servers

Ensure that the following services are running on all servers:
- .NET Runtime Optimization Service
- COM+ Event System
- HTTP SSL
- IIS Admin Service
- World Wide Web Publishing Service

Database Servers

Ensure that the following services are running on all Database Servers:
- SQL Server (MSSQLSERVER)
- SQL Server Agent (MSSQLSERVER)
- UCCMP Data Import Server
- UCCMP Replication Publisher
- UCCMP Replication Subscriber

**Web Application Servers**

Ensure that the following services are running on all Web Application servers:

- ASP.NET State Service
- UCCMP Application Search Services
- UCCMP Application Server
- Report Server

**User Rights**

Ensure that the **Network Service** and **sql_agent_user** accounts have log on as a service permissions.

**Network Connectivity**

Ping each of the servers to ensure all are available.
2. WINDOWS OPERATING SYSTEM CHECKS

Event Logs

Open up Event Viewer from Start > All Programs > Administrative Tools > Event Viewer.

On the Database Servers, look for errors raised by the following:

- SQL Server
- SQL Server Agent
- UCCMP Services

On the Web Application Servers, look for errors raised by the following:

- IIS
- MS Reporting Services
- Management Portal Services

Disk Space and Memory Usage

Use the Task Manager to check CPU and Memory utilization. High CPU and/or memory usage may impair performance, and is often caused by inappropriate applications (such as some screensavers) being run on the system.

Low disk space may cause problems if the SQL Server database and Transaction Log do not have enough space to grow when required. This typically results in provisioning failures.
3. SQL SERVER CHECKS

1. Check that SQL Server has been allocated no more than 70% of the RAM in the server (or 50% for single-sided, standalone installations). Allocating more RAM than this will result in poor performance from the other applications (including Management Portal components) on the server.

2. Ensure that dynamic RAM allocation is not being used, as this often results in over-allocation.

3. Open up Management Studio from Start > All Programs > Microsoft SQL Server > Management Studio and check database and Transaction Log space utilization.

4. In Management Studio, check the Replication Monitor for failing replication events.

5. Ensure that all scheduled tasks are reporting success. For details of any failing tasks, right-click on that task and select the Task History option.
4. UNIFIED CONTACT CENTER MANAGEMENT PORTAL CHECKS

Connectivity

Web Application Server to Database Server
1. Create a shortcut on the desktop of the Web Application Server with the file extension .udl
2. Double-click on the link. The Data Link Properties window will open
3. On the Provider tab, select OLE for SQL Server
4. On the Connection tab, enter the necessary details to connect to SQL Server

Common error messages include:
- **Login Failed/Access Denied** The user name or password are incorrect / do not have access to the SQL Server
- **SQL Server is unavailable or does not exist** The client was unable to access SQL Server over the network. Possible causes include:
  - Broken NW connection
  - DNS resolution failure
  - SQL Server Service or System down

All error codes presented through this interface are standard SQL Server messages.

Database Server to IPCC

Use the SQL Server Management Studio to log onto the Admin Workstation from the Database Server using SQL Server authentication.

SQL Server Transactions

The SQL Profiler allows you to monitor transactions being executed against a database.
1. Open the profiler from All Programs > Microsoft SQL Server > Performance Tools > SQL Server Profiler
2. Click File > New Trace and connect to the server
3. In the Events tab, select the following events:
   - Stored Procedures RPC:Completion
   - TSL SQL:BatchCompleted
4. Click Run

You can also choose to filter the requests, for example by Application Name. Most Management Portal requests will show as Management Portal Application Primary, though errors in reporting will show as Report Server.

**Note** The SQL Profiler only shows SQL that has executed. Broken/malformed SQL may never be executed and therefore may not show up in the profiler.

### Logs

**AppServer Log**

On the Web Application Server, navigate to the location where the Application Server Component was installed (by default this will have been `C:\Program Files\Management Portal\Application Server`) and open up the file `AppServer.log`.

Search for ‘Exception:’ and examine the details.

**Note** The AppServer log is a rolling log with a default maximum size of 4MB. Once this limit is reached, the oldest entries will be overwritten.

**IIS Log Files**

Web log files are found at `C:\WINDOWS\system32\LogFiles\W3SVC\ex<YYMMDD>.log`.

These contain details of all web server transactions, and refer to standard HTTP status codes.

A full list of HTTP status codes can be found at [http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html](http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html). Some routine codes include:

- 200 - OK
- 401 - Failed Authorization
- 404 - Page Not Found
- 500 - Internal Server Error

**Configuring the Web Log**

The logging output level for the Web Log is configured in the file `web.config` in the location where the Web Server component was installed (by default this will have been `C:\Program Files\Management Portal\Web`).

```xml
<system.diagnostics>
  <switches>
    <!-- 0 - none, 1 = error, 2 = warning, 3 = info, 4 = verbose -->
    <add name="LogLevelSwitch" value="2"></add>
  </switches>
  <assert assertuienabled="false"></assert>
</system.diagnostics>
```
Note: Verbose level tracing should not be used in a live system except for very short periods in extreme situations.

Audit Reporting
Audit trails for individual items and audit reports for an overview of provisioning are available from the Management Portal user interface. More information on how to use these is available from the Administration Manual and the User Guide.

System Monitoring
The status of the microflow scripts in use can be monitored from the Configuration Manager on the Database Server, or from the Monitor Report. These are described more fully in the Administration Manual.
5. COMMON ISSUES

Database Server Errors

Required Initial Data Import Never Stops

When installing, it is necessary to import data before setting up CallManagers. In some cases, this import does not appear to stop. This may indicate a database connection failure.

Use the Management Studio to verify that data is being imported to TB_DIM_AGENT in the database created by the Management Portal (by default, this is the Portal database). If it is, the import is proceeding normally.

If no data is being imported, ensure that the Read-only user on the Admin Workstation databases has DataReader permissions, and that other details such as the password are correct.

Active Importer Server Crash

If a server crash or otherwise unrecoverable error occurs on the active importer then the other side needs to be brought into service as quickly as possible. The Data Import Server is designed to minimize the down time before importing can be restarted.

The following steps describe the actions to perform on the inactive side.

1. Turn off the Data Import Server and Management Portal Replication Subscriber - it is very important that these services shutdown properly otherwise the system may be in an inconsistent state. If either of these fails to shutdown properly then they should be restarted and allowed to run for at least 30 minutes. This should give them sufficient time to recover their state and rollback any inconsistencies

2. Check the TS_IMP_DIRECTORY_STATUS table – this table contains one row for each replicated session directory. If there are any rows in this table which have a status other than F then the database state is inconsistent. The only recourse is to restart the
Data Import Server to give it time to recover. After approximately 30 minutes (see above) shutdown the Data Import Server service again. If there are still unfinished session directories then a double error has occurred in the platform – to correct this problem the database must be restored from backup before importing can proceed.

3. Assuming the services shutdown correctly and there were no unfinished session directories in the **TS_IMP_DIRECTORY_STATUS** table. The next step is to completely clear out the **Replicated** folder as it contains imported information from the crashed server and cannot be guaranteed. The data may also contain references to resources which will never arrive as the SQL Server replication link is down

4. Finally, set the import token to active and restart the Data Import Server services. The process for restoring what was the active importer is described in the next section

**Inactive Importer Server Crash**

Another failure mode to consider is a server crash which is not the active importer.

This scenario does not break import processing on the active importer. Data will continue to be imported on the active side and session directories will accumulate in the **ToReplicate** folder. These session directories cannot be replicated to the other side as it is unavailable so these will quite quickly use up available disk space.

The recommended approach is to re-configure **Replication.xml** on the active importer and remove the crashed server. All entries in the **ToReplicate** folder should then be deleted. This configuration change stops the disk filling up on the active importer.

```
<Replication>
  <Publisher PublisherId="ReplicationPublisher" ChunkSize="65536" Directory PollInterval="1000" BroadcastPeriod="10000">
    <LinkedServers>
      <LinkedServer ServerName="Importer">
        <ReplicateDirectory>"\Importer\ToReplicate"</ReplicateDirectory>
        <ReconnectionPeriod>"15000"</ReconnectionPeriod>
      </LinkedServer>
    </LinkedServers>
  </Publisher>
</Replication>
```
Once the failed server has been fixed, the following steps should be taken:

1. Switch off the Data Import Server and Unified Contact Center Management Portal Replication Publisher / Subscriber services.
2. Delete everything in the ToReplicate and Replicated folders on both servers.
3. Switch off SQL Replication between the two databases.
4. On the active importer take a snapshot of the SQL Server database and restore it on the failed side. At this point both databases contain identical data.
5. Bring up SQL Server replication between the two databases.

Each table imported by the importer has a tide mark. The tide mark is essentially a bookmark storing the location where everything has been imported up to. Everything after the tide mark has yet to be imported. The importer imports a chunk of available data from each file in turn and updates the tide mark afterwards. The tide marks are stored in a table called **TB_IMP_TIDEMARK** as shown below.

<table>
<thead>
<tr>
<th>TABLE_NAME</th>
<th>RESOURCE_INSTANCE_ID</th>
<th>TIDEMARK</th>
</tr>
</thead>
<tbody>
<tr>
<td>t_Call_Type_Half_Hour</td>
<td>BDC538B8-E08E-4F94-BCDD-FA9CF3F8969C3</td>
<td>38723B034B99</td>
</tr>
<tr>
<td>t_Peripheral_Half_Hour</td>
<td>BDC538B8-E08E-4F94-BCDD-FA9CF3F8969C3</td>
<td>38723B034B99</td>
</tr>
<tr>
<td>t_Agent_Store_Trace</td>
<td>BDC538B8-E08E-4F94-BCDD-FA9CF3F8969C3</td>
<td>38723B034B99</td>
</tr>
<tr>
<td>t_Agent_Half_Hour</td>
<td>BDC538B8-E08E-4F94-BCDD-FA9CF3F8969C3</td>
<td>38723B034B99</td>
</tr>
<tr>
<td>t_Twack_Group_Half_Hour</td>
<td>BDC538B8-E08E-4F94-BCDD-FA9CF3F8969C3</td>
<td>38723B034B99</td>
</tr>
<tr>
<td>t_Skill_Group_Half_Hour</td>
<td>BDC538B8-E08E-4F94-BCDD-FA9CF3F8969C3</td>
<td>38723B034B99</td>
</tr>
</tbody>
</table>

On the **failed** server the following changes must be made:

1. The tide marks in **TB_IMP_TIDEMARK** will be incorrect once the database has been restored on the failed side. So delete all rows from the table which contains the failed server’s **RESOURCE_INSTANCE_ID**. On the failed server call **ap_clu01_get_exony_db_resource_instance** from SQL Server Management Studio to get its **RESOURCE_INSTANCE_ID**.
2. After deleting all the rows for the failed database server - duplicate each remaining row in the TB_IMP_TIDEMARK table. Each duplicated row must have its RESOURCE_INSTANCE_ID changed to the failed server identifier. By doing this it ensures that both servers have identical tide marks and so match the data in the fact tables and dimensions.

The following SQL can be used to update TB_IMP_TIDEMARK:

```sql
CREATE TABLE #TEMP (RESOURCE_INSTANCE_ID UNIQUEIDENTIFIER, CATALOG VARCHAR (50))
INSERT #TEMP
EXECUTE ap_clu01_get_exony_db_resource_instance
DECLARE @v_RESOURCE_INSTANCE_ID UNIQUEIDENTIFIER
SELECT @v_RESOURCE_INSTANCE_ID = RESOURCE_INSTANCE_ID FROM #TEMP
DELETE FROM TB_IMP_TIDEMARK
WHERE RESOURCE_INSTANCE_ID = @v_RESOURCE_INSTANCE_ID
INSERT TB_IMP_TIDEMARK (CLUSTER_RESOURCE_ID, TABLE_NAME, RESOURCE_INSTANCE_ID, TIDEMARK1, TIDEMARK2, TIDEMARK3, TIDEMARK4)
SELECT CLUSTER_RESOURCE_ID, TABLE_NAME, @v_RESOURCE_INSTANCE_ID, TIDEMARK1, TIDEMARK2, TIDEMARK3, TIDEMARK4
FROM TB_IMP_TIDEMARK
```

Fact tables are not replicated through SQL Server but via the Unified Contact Center Management Portal Replication system. When importer session files are replicated from one side to another, they are bulk loaded by the Data Import Server into the database. As this process takes place, the Data Import Server logs its progress into a series of state tables in the database.
These importer state tables are replicated using standard SQL Server replication but are uniquely identified on each side via a RESOURCE_INSTANCE_ID. The system on each side uses these state tables to track the arrival of new data into the database fact tables for further processing.

**TB_IMP_FCT_PARTITION** is the base state table. This contains a definition of all the fact table partitions that have been created on each side. There are usually two identical rows in here, differentiated by RESOURCE_INSTANCE_ID (one for each side). This table links to TB_IMP_FCT_PARTITION_TIDEMARK and TB_IMP_FCT_PARTITION_TIDEMARK_SLICE.

Unfortunately, when one database is restored to another side, these state tables are no longer correct. As a result, data may exist in the fact partitions in the restored database that the system has no idea exists. The following steps recover the state tables on the failed database. It is very important that SQL Server replication is running while these steps are performed.

3. Delete all data from TB_IMP_FCT_PARTITION with the RESOURCE_INSTANCE_ID of the failed database. This should cascade delete data from all the other state tables.

4. All the data in the following tables must be duplicated using the failed database RESOURCE_INSTANCE_ID. This essentially matches the state tables with the actual data in the database fact tables.
   - TB_IMP_FCT_PARTITION
   - TB_IMP_FCT_PARTITION_TIDEMARK
   - TB_IMP_FCT_PARTITION_TIDEMARK_SLICE

5. **Replication.xml** on the active importer can now be reset and the Data Import component server service along with the Unified Contact Center Management Portal Replication Publisher / Subscriber services can be restarted on both servers. The Data Import component server will start importing and replicating data to the other side as normal.

**Recovery after No Disk Space Available**

If there is no disk space for the importer it will continue trying and failing to import data until disk space is made available. However the importer should always reset the Unified Contact Center Management Portal database to a consistent state. Sometimes the importer cannot back out changes it has made to the database until disk space is made available (for example, disk space is often required by the SQL Server transaction log before changes are committed).

There are several places where running out of disk space can cause an import to fail. For example when the importer reloads a dimension cache, it saves it to a session file on disk. The same occurs when the importer is processing downloads from the Admin Workstation. It is therefore difficult
to specify exactly where the importer will fail when there is no disk space left.

In all cases the importer should generate an exception (visible in the importer trace) and stop the current import. Once disk space is made available the importer should reset the database to a consistent state and start importing again.

**Network Disconnects in Replicated Environments**

There are two types of replication connection between the database servers. The first is SQL Server replication which is used to replicate dimension, member and administration tables in the Unified Contact Center Management Portal database. The second connection is used by the Data Import Server to replicate high volume fact data between the systems. If this connection is broken, both replication connections are expected to stop.

While the connection is down disk space will fill up on the active importer. This is because it is accumulating session files from the running importer which cannot be replicated to the other side. Once the connection is re-established the session files waiting to be replicated will be processed and data should not be lost as a result.

Once the connection is re-established both connections should start working again and catch up where they left off. For SQL Server replication this can be monitored through the Management Studio Replication Monitor. Data Import Server replication can be monitored by opening Windows Explorer on the configured `ToReplicate` folder.
Replication Fails on Replication Restart

Transaction Log Full

An extended interruption of replication may result in the Transaction Log becoming full. No logged operations can be performed while the Transaction Log is in this state.

First, check that the transaction log is indeed full. If certain that the underlying issue has been fixed, extend the Transaction Log. This will allow operations to be performed again. Once the system has recovered, use DBCC SHRINKFILE to shrink the log back to normal size.

Record Duplication

It sometimes happens that while replication is down, the same user is created on both the publisher and the subscriber. When replication is brought back up again, the presence of two records containing fields that must be unique (such as the login name) causes replication to fail.

This problem can be confirmed by checking the event viewer for an event with a description that includes the phrase ‘violation of UNIQUE KEY constraint’.

To solve this problem, it is necessary to delete one of the duplicate records.

To find the record causing the problem:

1. Go to the subscriber database and expand the Portal database
2. Navigate to Replication Monitor > Publishers > Publisher Database Name and click on Base:Portal publication
3. In the left-hand window, right-click on the Distribution Agent for Base publication (this will be displayed as Subscriber Database Name:Portal)
4. Select **Agent History** and the Distribution Agent History window will open. This will give information about the error and the place where the conflict is occurring.

5. To find the record in the table where this error is occurring, right-click on the **Base:Portal** publication (Replication Monitor > Publishers > Publisher Database Name) and click on View Conflicts. This will open the Replication Conflict Viewer window.

6. Select the table that you suspect the conflict to be in and click View.

![Replication Conflict Viewer](image)

7. Click on **Postpone Resolution** until you reach the place where you suspect the conflict is not resolved. In the above case it is the BillThomson LOGIN_NAME that is creating a conflict. You must then manually check on both sides for the duplicated record and delete one of them from the system. Once this is completed, the system will immediately replicate all records that were pending replication.

**Re-sychronizing Replication**

If normal replication is suspended for an extended time (by default, this is two weeks), it will be necessary to re-initialize replication.

From SQL Server Management Studio, check that re-synchronization is needed. Then right-click on the Publication to be re-synchronized and select the **Reinitialize** option. Monitor the progress of the Snapshot agent to ensure it completes successfully.
Domain Controller was Rebooted

Problems are occasionally seen after rebooting a domain controller. The solution is to reboot the Unified Contact Center Management Portal servers. If domain security policies do not allow cached account credentials then the domain controller must be available when the Management Portal servers restart (otherwise they will not be able to authenticate against the domain).

Taking a Cisco Admin Workstation Offline

No special action needs to be taken in this instance. While an Admin Workstation is offline the Unified Contact Center Management Portal will not be able to import any data from that system. It will however continue to import data from other Admin Workstations as normal.

Because the Admin Workstation is offline no provisioning actions will be completed for the tenant who has been allocated that Admin Workstation. This means that tenant’s resources will remain in a synchronizing state forever. Once the Admin Workstation is back online the system automatically starts using it again.

System Monitoring / Monitoring Report Shows Errors

This is typically because the remote system (ICM/CICM or CallManager) is not currently available. This may be because of a network disconnection or other service fault on the remote system. It is probably worth checking that the ICM or CICM is up and running correctly (in particular the CMS control in Configuration Tools).

Cannot Login to Phone / Phone Does Not Ring

If the CallManager peripheral user name is entered incorrectly in the Management Portal Configuration Manager tool, then logging into the phone will not be possible. Furthermore ICM will not be able to control the phone properly and so it will not ring.

The solution is to first correct the peripheral user name in the Management Portal Configuration Manager tool. Then each phone must be loaded in the System Manager tool in Portal’s web interface and saved. The Management Portal will update the CallManager / ICM and reconfigure the phone correctly.

Note It is very important that the peripheral user name is not changed after the system is commissioned. The peripheral user name must also be unique across a peripheral.

Web Application Server Errors

A Tenant’s Resources are not being moved to the Correct Folder after Import

1. Login to the Unified Contact Center Management Portal as a system administrator.
2. In the System Manager navigate to the folder containing the tenant.
3. Click on the tenant and wait for the right hand pane to load.
4. Click the Prefixes table and edit the prefixes as appropriate.
5. Click Save to submit the changes into the system.

<table>
<thead>
<tr>
<th>Prefix Type</th>
<th>Priority</th>
<th>Enable</th>
<th>Path</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc</td>
<td>1</td>
<td></td>
<td>/ipcc1/Q A Testing</td>
<td></td>
</tr>
</tbody>
</table>

For Cisco ICM or CICM the prefix management works from the resource’s enterprise name. So in the example rule above, if the agent’s name begins with abc then it will automatically be moved to the folder /ipcc1/Q A Testing. If more than one prefix rule is applicable then the rule with the lowest priority number is used.

**Unable to See Resources in System Manager**

This is probably because the user does not have Browse Dimensions security privileges. It is best practice to assign security permissions through security groups rather than to individual users. The Unified Contact Center Management Portal User Guide explains how to configure security users / groups and how to assign permissions to them.

**Unable to Provision Resources through System Manager?**

The user probably needs a global provisioning security privilege, for example, Provision Agent. It is best practice to assign security permissions through security groups rather than to individual users. The Unified Contact Center Management Portal User Guide explains how to configure security users / groups and how to assign permissions to them.

**Resource Stays in Pending Active State Forever**

This may be because the system has been unusually busy. The first check is in the history tab for the resource. This shows any activity taken by the system for that resource. If the system unsuccessfully attempted to make a change on the ICM/CICM or CallManager then that information is normally recorded in the audit history. If the audit history has not been updated then it may indicate that the Unified Contact Center Management Portal microflow scripts are offline.

It is possible to manually run the microflows that synchronize the Management Portal with IPCC. To do this, from the Database Server:

1. Navigate to where the Management Portal has been installed (usually C:\Program Files\Management Portal)
2. Open the Data Import Server folder and run MicroExplorer.exe
3. In the Microflow Explorer window, browse to $C:\Program Files\Management Portal\Data Import Server\Config\Microflows.xml$

4. Select the **Provision** microflow

5. Click **Run**. The Microflow Runtime Debugger will open.

6. Click **Run** again. The Portal will synchronize

**Caution:** The Microflow Explorer should not be used to edit microflows unless instructed to do so by support personnel.

### When Creating New Item, Error Indicates Resource Already Exists

This indicates that the resource you are trying to create shares a field that must be unique, such as a Person’s login name or a Dialed Number’s number, with an existing resource.

If no duplicate resource appears to exist, this may indicate that the resource has been deleted. Deleted resources are marked as deleted but kept in the system for audit purposes, and so it is possible for a new resource to have a conflict with an old one. You can see deleted items within the system by checking the **Show Deleted Resources** checkbox in **Settings > User Settings**.

If a conflict exists you will not be able to create the new resource unless you change the conflicting detail.

### New Skillgroups Enter Error State

Attempting to create a skillgroup gives the error: ‘You do not have permission to create this object. It should be created by the Application that owns the media type on which you are attempting to create this object. [Code 40062]’ in the Skillgroup History tab. This error is caused by setting multimedia support for the ICM in the VIM Configuration Manager, but not setting VIM to use a Cisco Unified Web and E-Mail Interaction Manager Application Instance.

If you do not have Cisco Unified WIM/EIM integrated with your version of IPCC, you will need to log onto the Database Server, open the Configuration Manager and uncheck the **Multi Media** checkbox for the relevant ICM. You should also log onto the ICM and ensure that the Application Instance being used is set to **Cisco Voice**.

If you are using Cisco Unified WIM/EIM integrated with IPCC, log onto the Database Server, open the Configuration Manager, and change the Application Instance details for the relevant ICM to correspond to those set up for the Cisco Unified WIM/EIM. Information on configuring the Application Instance for a Cisco Unified Interaction Manager deployment can be found in the **Cisco Unified Web and E-Mail Interaction Manager System Administration Guide For Unified Contact Center Enterprise and Hosted and Unified ICM**.
Unable to Update Skillgroup Memberships

Attempting to update an agent skillgroup membership gives the error: ‘‘AgentSkillGroupMember failed [4,Attempt to assign a Member to a default skill group]’’ in the Agent History tab. This error is caused by an incorrect Application Instance type on the ICM. Log onto the ICM and change the Application Instance type to Cisco Voice.

Unable to see Related Resources in System Manager

This is probably because the user does not have Browse Dimensions security privileges on the folders where the related resource is located. For example, to add an agent to a skill group requires Browse Dimensions security privileges on the folder where the skill group is located. It is best practice to assign security permissions through security groups rather than to individual users. The Unified Contact Center Management Portal User Guide explains how to configure security users / groups and how to assign permissions to them.

Unable to Bulk Load Resources in System Manager

This is probably because the user does not have the Bulk Import Dimensions security privilege. This security privilege is a global task and so is configured in a global role. A user must be granted the global role. The user must also be granted the provisioning global task to bulk upload particular resource types, for example Provision Agents.
Web Browser Displays “No connection could be made because the target machine actively refused it”

Check the Unified Contact Center Management Portal services are all up and running on the web component server.

Web Browser Displays “The page cannot be found”

Check the URL in the web browser is correct (in particular the server name / IP address of the Unified Contact Center Management Portal server).

Supervisor User has no Agents or Skillgroups menu options

Check whether the user’s home folder is one they have permission to manage resources in.

When moving users or changing their permissions it is a common error to neglect to change their home folder. In Basic Mode, a user is automatically set to work in the folder specified as their home folder, and
if they do not have permission to manage dimensions in that folder they will not be able to access the **Agents** or **Skillgroups** menu options. This is not a problem for Advanced Users because whereas Basic Mode presents a flat view, the tools available in Advanced Mode allow the user to change the folder in which they are working.

**Sharing IPCC Lines**

In IPCC, two types of line exist: CallManager internal lines and ICM/CICM controlled lines. For ICM controlled lines the Unified Contact Center Management Portal automatically configures the necessary device targets and labels on ICM. Note however that an ICM controlled line can only be associated with one phone in the Unified Contact Center Management Portal and cannot be shared. For CallManager internal lines, multiple phones can share the same line.

**Error Importing Phone**

Only supported phone types are imported into the Unified Contact Center Management Portal, all others are filtered out and will not be visible in the System Manager. If the Data Import component server fails when importing a phone from CallManager it will change the state of the phone to **error**. To resolve this problem, load the phone in the System Manager and click **Save**. The system will then synchronize the phone with CallManager and resolve any problems.

**Phone Button Templates**

Button templates are imported from the CallManager but cannot be edited or created in the Unified Contact Center Management Portal. The number of lines can be set in a phone template on the CallManager but this is not reflected in the Unified Contact Center Management Portal. This means a phone can be assigned to more lines in the System Manager than the button template actually permits.

**Can’t See Audit Reports in Management Portal?**

This is probably because the user does not have **Browse Reports** security privileges on the folder where the audit report is located.

**“Object reference not set to an instance of an object” When Running a Report**

The Unified Contact Center Management Portal uses an internal indexing system to keep track of all resources in the system. This can take several minutes to load after the system starts. If the system has recently started up, wait five minutes and then try again.

**No Data in Report**

1. Open the parameter set and then click **Preview**. Check that there are resources listed as the Unified Contact Center Management Portal uses these to generate the report.
2. If the parameter set includes folders, check that these folders exist and that the user has the **Browse Dimensions** security privileges on them.

3. Check the parameters configured when viewing the report. Some reports have date ranges which can either be relative (for example, from last week, to today) or absolute (for example, from 2005-07-25, to 2005-12-31).

**Unable to Print Reports**

Printing requires the Microsoft Reporting Services ActiveX control to be downloaded to the client machine. The browser’s security settings might need to be modified to allow an ActiveX control download from the Management Portal web site.
6. INDEX

A
Access Denied ..................................11
Admin Workstation
Taking offline ...................................22
AgentSkillGroupMember failed
[4, Attempt to assign a Member to a
default skill group] ..............................25
Application Instance .........................24, 25
Audit trails .....................................13

B
Button templates ...............................27

C
CallManager ..................................14, 22, 27
CMS control ...................................22
Configuration
Configuring the Web Log .......................12
Portal Configuration Manager ..............22
Connectivity ...................................8, 11
Crash
Active Importer Server .......................14
Inactive Importer Server ....................15

D
Data
Data import disk space ......................18
Data import never stops ....................14
Missing data in database ...................18
Missing data in report .......................27
DBCC SHRINKFILE ..........................20
Deleted resources ............................24
Disk space .....................................9
Causing import failure ......................18
Domain Controller ...........................22
Duplicate resources .........................20, 24

E
Enterprise Manager......See Management
Studio
Error
CallManager ....................................7
ICM ...............................................7
Message .......................................7, 12, 24, 25
Event Viewer ...................................9

F
Fact table ......................................17

H
Home folder ....................................26

I
ICM ...............................................22, 27

L
Lines
Number set in template ......................27
Sharing .........................................27
Logged operations ...........................20
Login Failed .................................11, 25
Logs
Application Server Log ......................12
Event Log ..................9, 10, 20
Transaction Log .............................12
Web Log ........................................9

M
Management Studio
Checking connectivity ......................11
Checking log space utilization .............10
Replication monitoring .....................19, 21
Tide mark updating ...........................16
Memory ...........................................9
Dynamic RAM allocation ....................10
SQL Server ....................................10
Microflow .....................................13
Running manually .........................23

N
No connection could be made because
the target machine actively refused it
....................................................26

O
Object reference not set to an instance of
an object .....................................27

P
Page cannot be found .......................26
Pending Active ..............................23
Peripheral ....................................22
Phone
Button templates .............................27
Error ...........................................27
Not ringing ...................................22
Sharing lines .................................27
Prefix .........................................23
<table>
<thead>
<tr>
<th>Q</th>
<th>Query Analyzer See Management Studio</th>
</tr>
</thead>
</table>
| R | Replicated folder Deleting from .......... 16  
Replication.................................. 10, 19, 20  
Extended outage ......................... 20, 21  
Re-synchronizing........................... 21  
Switching off SQL replication.............. 16  
Replication.xml.............................. 18  
Reports Audit trails................................ 13  
Missing data .................................... 27  
Missing reports .............................. 27  
Object reference not set to an instance of an object .......... 27  
Unable to print............................. 28  
Resources Deleted .................................. 24  
Duplicate ........................................ 20, 24  
Importing to tenant folder ............... 22  
Missing ......................................... 23  
Related ......................................... 25  
Staying in Pending Active ............... 23  
Unable to provision ....................... 23  
Uploading ....................................... 25  
S | Services ........................................... 7  
.NET Runtime Optimization Service ...... 7  
ASP.NET State Service .................. 8  
COM+ Event System .......................... 7  
HTTP SSL ........................................ 7  
IIS Admin Service ......................... 7  
Management Portal Application Search  
Services ........................................... 8  
Management Portal Application Server .. 8  
Management Portal Data Import Server, 8, 14  
Management Portal Replication Publisher ........................................... 8  
Management Portal Replication  
Subscriber ..................................... 8, 14  
Report Server .................................. 8  
SQL Server (MSSQLSERVER) .............. 8  
SQL Server Agent (MSSQLSERVER) .... 8  
World Wide Web Publishing Service .... 7  
Skillgroup ...................................... 24, 25  
Snapshot ...................................... 21  
SQL Profiler .................................... 11  
SQL Server ....................................... 10  
SQL Server is unavailable or does not exist .......... 11  
Transactions .................................. 11  
State table .................................... 17  
Recovering .................................... 18  
Supervisor User  
Missing menu options .................... 26  |
| T | TB_DIM_AGENT .................................... 14  
Telephone Button templates ............ 27  
Error ........................................... 27  
Not ringing .................................. 22  
Sharing lines ................................. 27  
Tide mark ....................................... 16  
Update ......................................... 17  
T-Log .................. See Logs: Transaction  
ToReplicate folder  
Accumulating data ....................... 15  
Deleting from ............................... 15  
Replication monitoring .................. 19  
TS_IMP_DIRECTORY_STATUS .... 14  
U | Uploading resources ....................... 25  
User Network Service ..................... 8  
sql_agent_user .................................. 8  |
| V | Violation of UNIQUE KEY constraint ........ 20  |
| W | web.config ..................................... 12  |
| Y | You do not have permission to create this object. It should be created by the Application that owns the media type on which you are attempting to create this object .......... 24 |